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1. Introduction to LPCXpresso

LPCXpresso is a low-cost microcontroller (MCU) development platform ecosystem from
NXP, which provides an end-to-end solution enabling embedded engineers to develop their
applications from initial evaluation to final production.

The LPCXpresso platform ecosystem includes:

• The LPCXpresso IDE, a software development environment for creating applications for
NXP’s ARM based ‘LPC’ range of MCUs.

• The range of LPCXpresso development boards, which each include a built-in ‘LPC-
Link’ or ‘LPC-Link2’ debug probe. These boards are developed in collaboration with
Embedded Artists.

• The standalone ‘LPC-Link 2’ debug probe.

This guide is intended as an introduction to using LPCXpresso, with particular emphasis
on the LPCXpresso IDE. It assumes that you have some knowledge of MCUs and software
development for embedded systems.

1.1  LPCXpresso IDE Overview of Features

The LPCXpresso IDE is a fully featured software development environment for NXP’s
ARM-based MCUs, and includes all the tools necessary to develop high quality embedded
software applications in a timely and cost effective fashion.

The LPCXpresso IDE is based on the Eclipse IDE and features many ease-of-use and
MCU specific enhancements. The LPCXpresso IDE also includes the industry standard
ARM GNU tools enabling professional quality tools at low cost. The fully featured debugger
supports both SWD and JTAG debugging, and features direct download to on-chip flash.

For the latest details on new features and functionality, visit http://www.lpcware.com/
content/forum/lpcxpresso-latest-release

1.1.1  Summary of Features

• Complete C/C++ integrated development environment

• Latest Eclipse-based IDE with many ease-of-use enhancements

• Eclipse Luna (v4.4) and CDT (8.6)

• IDE can be further enhanced with Eclipse plugins

• CVS source control built in; Subversion, TFS, Git, and others available for download

• Command-line tools included for integration into build, test, and manufacturing
systems

• Industry standard GNU toolchain (v4.9.3), including

• C and C++ compilers, assembler, and linker

• Converters for SREC, HEX, and binary

• Fully featured debugger supporting JTAG and SWD

• Built-in flash programming

• High-level and instruction-level debug
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• Views of CPU registers and on-chip peripherals

• Support for multiple devices on JTAG scan-chain

• Library support

• Redlib: a small-footprint embedded C library

• Newlib: a complete C and C++ library

• NewlibNano: a new small-footprint C and C++ library, based on Newlib

• LPCOpen MCU software libraries

• Cortex Microcontroller Software Interface Standard (CMSIS) libraries and source code

• Device-specific support for NXP’s ARM-based MCUs (including Cortex-M, ARM7 and
ARM9 based parts)

• Automatic generation of linker scripts for correct placement of code and data into flash
and RAM

• Startup code and device initialization

• No assembler required with Cortex-M based MCUs

• Trace  [41]

• Instruction trace via Embedded Trace Buffer (ETB) on certain Cortex-M3/M4 based
MCUs or Micro Trace Buffer (MTB) on Cortex-M0+ based MCUs

• SWO Trace on Cortex-M3/M4 based MCUs when debugging via LPC-Link2, providing
functionality including

• Profile tracing

• Interrupt tracing

• Datawatch tracing

• Red Trace on Cortex-M3/M4 based MCUs when debugging via Red Probe+ (legacy)

• Red State  [96] state machine designer and code generator

• Graphically design your state machines

• Generates standard C code

• Configures NXP State Configurable Timer (SCT) as well as supporting software state
machines

1.1.2  Supported debug probes

The following debug probes are supported by LPCXpresso IDE for general debug
connections:

• LPC-Link (LPCXpresso board)

• LPC-Link 2 (with “Redlink” or “CMSIS-DAP” firmware) - either the standalone debug
probe or the version built into LPCXpresso V2 and V3 boards
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• CMSIS-DAP enabled debug probes, such as LPC800-MAX, LPCXpresso824-MAX, Keil
ULINK-ME etc.

• Red Probe / Red Probe+

• RDB1768 development board built-in debug connector (RDB-Link)

• RDB4078 development board built-in debug connector

For more information on debug probe support in LPCXpresso IDE, visit http://
www.lpcware.com/content/faq/lpcxpresso/supported-debug-probes-mcus

Support for GDB server based debug connections is also provided. This feature enables
support for 3rd party debug probes, such as Segger J-Link. When debugging with GDB
server connections, some functionality may be disabled.

• For more information on using Segger J-Link with LPCXpresso, visit http://
www.segger.com/nxp-lpcxpresso.html

1.2  LPCXpresso Development Boards (original version)

Since first introduced in 2009, the original LPCXpresso family of boards, along with the
associated LPCXpresso IDE, has re-energised the whole MCU evaluation board market.

Developed in collaboration with Embedded Artists, each LPCXpresso board contains a
JTAG/SWD debug probe called “LPC-Link” and a target MCU. LPC-Link is equipped with
a 10-pin JTAG/SWD header and it seamlessly connects the LPCXpresso IDE to the target
MCU via USB (the USB interface and other debug features are provided by NXP???s ARM9
based LPC3154 MCU). The target includes a small prototyping area and easily accessible
connections for expansion. An LED is also fitted as standard, with some board variants
having additional fittings such as an RGB LED, potentiometer or USB device connector.

An LPCXpresso board with its on-board target MCU can be used either on its own for
software development and benchmarking or connected to an off-the-shelf baseboard, such
as those available from Embedded Artists, for rapid proof-of-concepts.
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Figure 1.1. LPCXpresso development board

Cutting the tracks between the LPC-Link and the target will change the LPC-Link into
a standalone JTAG/SWD debug probe. This enables the LPCXpresso platform to be
connected to an external target, which may be an off-the-shelf commercial development
board or a target board of your own design.

For more information, visit:

http://www.lpcware.com/LPCXpressoBoards

1.3  LPC-Link 2 Debug Probe

The LPC-Link 2 is a new generation of debug probe. It is powered by an NXP LPC4300
series MCU, and includes a standard 10-pin JTAG/SWD connector; a 20-pin JTAG/SWD/
ETM connector; and analog, digital and serial expansion headers, making it a highly
extensible platform. Unlike the original “LPC-Link” it does not contain a target MCU, but is
rather designed to be used with a target mounted on an external board.

The LPCXpresso IDE works out of the box with LPC-Link 2 by soft-loading “CMSIS-DAP”
or “Redlink” firmware. In addition, firmware images are available to program into the flash
of LPC-Link 2 that make it compatible with other toolchains, including the popular SEGGER
J-Link and the CMSIS-DAP debugger designed by ARM.
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Figure 1.2. LPC-Link 2 Debug Probe

For more information, visit:

http://www.lpcware.com/lpclink2

1.4  LPCXpresso V2 and V3 Boards

The next generation LPCXpresso V2 and V3 boards build upon the original LPCXpresso
board design, providing many new and exciting features. These include a new debug probe
based on the standalone LPC-Link2, as well as enhanced expansion capabilities.

Figure 1.3.  LPCXpresso V2 Board (LPCXpresso11U68)

For more information, visit:

http://www.lpcware.com/LPCXpressoBoards

1.5  LPCXpresso MAX Board

The LPCXpresso-MAX family of boards provide a powerful and flexible development
system for some of NXP’s low end MCUs, such as the LPC812 and LPC824. The built
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in CMSIS-DAP debug probe allows them to be used out of the box with a range of
development tools, including the LPCXpresso IDE, as well as with ARM’s mbed online
toolchain.

Figure 1.4. LPCXpresso812-MAX Board

For more information, visit:

http://www.lpcware.com/LPCXpressoBoards
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2. Installation and Licensing

2.1  Host Computer Hardware Requirements

Before installation of the LPCXpresso IDE, you should make sure your development host
computer meets the following requirements:

• A standard x86 PC with 2GB RAM minimum (4GB+ recommended) and 900MB+ of
available disk space, running one of the following operating systems:

• Microsoft® Windows Vista

• Microsoft® Windows 7

• Microsoft® Windows 8.1

• Microsoft® Windows 10

• Linux – Ubuntu 12 and later

• Linux – Fedora 18 and later

• An x86 Apple Macintosh with 2GB RAM minimum (4GB+ recommended) and 900MB+
of available disk space, running one of the following Mac OS X versions:

• 10.8.5 (or later) / 10.9.4 (or later) / 10.10 (or later)

Additional host platform notes:

• Starting with LPCXpresso v7.1, and following the discontinuation of support by Microsoft,
Windows XP is no longer an officially supported platform. LPCXpresso may continue to
work on Windows XP but this can no longer be guaranteed. LPCXpresso is no longer
tested on Windows XP.

• Starting with LPCXpresso v7.4, Mac OS X 10.7 (Lion) is no longer an officially supported
platform. LPCXpresso may continue to work on Mac OS X 10.7 but this can no longer
be guaranteed. LPCXpresso is no longer tested on Mac OS X 10.7.

• Both 32-bit and 64-bit Windows / Linux systems are supported.

• The LPCXpresso IDE may install and run on other Linux distributions. However, only the
distributions listed above have been tested. We have no plans to officially support other
distributions at this time.

• A screen resolution of 1024x768 minimum is recommended.

• An internet connection is required to request, install, and activate license keys. When
using the product, an internet connection is required to update the product and to
download new examples.

2.2  Installation

When installing, all components of the LPCXpresso IDE are installed, but some functionality
may be restricted by the currently installed license activation.

2.2.1  Windows

The LPCXpresso IDE is installed into a single directory, of your choice. Unlike many
software packages, the LPCXpresso IDE does not install or use any keys in the Windows
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Registry, or use or modify any environment variables (including PATH), resulting in a very
clean installation that does not interfere with anything else on your PC. Should you wish
to use the command-line tools, a command file is provided to set up the path for the local
command window.

2.2.2  Linux

Due to the huge variation in capabilities of different Linux distributions, LPCXpresso is only
tested and supported on recent distributions of Ubuntu and Fedora. The LPCXpresso IDE
may work on other distributions but we cannot provide support if it does not work.

The installer is supplied as an executable that installs the LPCXpresso IDE components.
The installer requires root privileges, although, once it is installed, no special privileges are
required to run the LPCXpresso IDE. The installer will request a super-user password when
it is started. Once installation has completed, we strongly recommend that your system is
restarted — if you do not do this then some areas of the tools may not function correctly.
The installer should be started from the command line, but will switch to GUI mode once
the super-user password has been entered.

  Installation on 32-bit distributions

The LPCXpresso IDE is a 32-bit product that should run on most 32-bit Linux distributions.
On some distributions some additional packages may be required for USB compatibility
(see below for the latest information). Note that GLIBC v2.15 or greater is required.

  Enabling the LPCXpresso IDE internal Web Browser

On most recent Linux distributions, an additional package must be installed to enable the
IDE’s internal Web Browser. If this is not installed, any web pages displayed by the IDE will
be displayed in the system default Web Browser.

  Ubuntu

Run the following command to install the webkit package that enables the internal Web
Browser:

 sudo apt-get install libwebkitgtk-1.0-0

  Fedora

Run the following command to install the webkit package that enables the internal Web
Browser:

 sudo yum install webkitgtk.i686

  Installation on 64-bit distributions

The LPCXpresso IDE is a 32-bit product. For 64-bit versions of Linux, the 32-bit
compatibility components must be installed. Note that all of these components must be
installed, otherwise the installation program will not run and the LPCXpresso IDE will
not function correctly. To install these components from the command line, follow the
instructions below for your distribution.

  Ubuntu 13.10 or later:

Ubuntu 13.10 no longer provides a convenient method to install all 32-bit compatible
libraries, so they must all be installed individually. Those that are required for LPCXpresso
7 are as follows:
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 sudo apt-get install libgtk2.0-0:i386 libxtst6:i386 libpangox-1.0-0:i386 \ 

      libpangoxft-1.0-0:i386 libidn11:i386 libglu1-mesa:i386 \

      libncurses5:i386 libudev1:i386 libusb-1.0:i386 libusb-0.1:i386 \

      gtk2-engines-murrine:i386 libnss3-1d:i386 libwebkitgtk-1.0-0

  Ubuntu 13.04 or earlier:

Ubuntu 13.04 and earlier provides a convenient method to install 32-bit compatible libraries.
These can be installed using the follow command:

 sudo apt-get install linux32 ia32-libs 

  Fedora

Install the following 32-bit libraries:

 sudo yum install gtk2.i686 glibc.i686 glibc-devel.i686 libstdc++.i686 \

  zlib-devel.i686 ncurses-devel.i686 libX11-devel.i686 libXrender.i686 \

  libXrandr.i686 libusb.i686 libXtst.i686 nss.i686 libcanberra-gtk2.i686 \

  PackageKit-gtk3-module.i686 webkitgtk.i686

  Other Linux Distros

While not officially supported, the LPCXpresso IDE has been reported to work on many
other Linux Distros, including Linux Mint, openSUSE and Debian. When attempting to run
on these Distros, remember that LPCXpresso is a 32-bit application and so various 32-bit
compatible libraries must be installed. These include:

 libgtk2.0-0:i386 libxtst6:i386 libpangox-1.0-0:i386 libpangoxft-1.0-0:i386 \

 libidn11:i386 libglu1-mesa:i386 libncurses5:i386 libudev1:i386 \

 libusb-1.0:i386 libusb-0.1:i386 gtk2-engines-murrine:i386 \

 libnss3:i386

Also note that that the glibc 2.15 shared library is required.

We are unable to provide assistance when installing on other Distros, but the LPCXpresso
forum on http://www.lpcware.com is a good place to search for information or post
questions.

  Post-installation issues

  dfu-util fails to run

On some Linux systems, when booting LPC-Link or LPC-Link2, the supplied version of dfu-
util may fail to execute. To resolve this you may need to install an additional component:

  sudo apt-get install libusb-0.1-4:i386 # Ubuntu

This should only be installed on systems where dfu-util fails to run.

  Connection Refused error

When starting a debug session, on some Linux systems, a "Connection refused" error
may be displayed. This happens because a critical system library is not installed where
we expect to find it.



NXP Semiconductors LPCXpresso v7 User Guide

LPCXpresso v7 User Guide -

User Guide
All information provided in this document is subject to legal disclaimers

Rev. 7.9 — 12 September, 2015
© 2013-2015 NXP Semiconductors. All rights reserved.

10

To resolve this issue, open a Terminal Window and execute the following commands (if
running a 64-bit version of Linux, you must first install the 32-bit compatibility libraries as
described above):

Note: The actual location of this library may depend on the distribution and version of Linux
you are running.

  Ubuntu

 cd /lib/i386-linux-gnu

 sudo ln -sf libudev.so.1 libudev.so.0

  Fedora

 cd /usr/lib/

 sudo ln -sf libudev.so.1 libudev.so.0

  Ubuntu-specific issues

When using the Unity interface, there may be an issue preventing some menu items
from displaying in the LPCXpresso IDE (this does not affect the ‘Classic’ interface). To
workaround this problem, create a shell script with the following content, and start the
LPCXpresso IDE by running this script:

 #!/bin/bash

 export UBUNTU_MENUPROXY=0

 /usr/local/<lpcxpresso_install_dir>/lpcxpresso/lpcxpresso

  Fedora-specific issues

If SELINUX is used, it must be set to “permissive” mode to allow the LPCXpresso IDE to run.

2.2.3  Mac OS X

The LPCXpresso IDE installer is supplied as a Mac OS X .pkg installer file. Double click on
the installer to install the LPCXpresso IDE into a subfolder of your Applications folder.

To start the LPCXpresso IDE, use the Mac OS X Launchpad. Alternatively click the Open
lpcxpresso icon in the /Applications/lpcxpresso_version folder or run lpcxpresso.app,
which can be found in the lpcxpresso subfolder of the main LPCXpresso IDE installation
directory within /Applications.

2.2.4  Running under virtual machines

It is possible to install the LPCXpresso IDE within a virtual machine (VM) environment.
Generally such installations cause few issues. However due to the nature of VMs the most
likely problems relate to sharing of resources (USB, memory), and possible timeouts during
debug operations.

In the unlikely event that you experience issues, we welcome reports but due to the nature
of VM operation can offer no guarantee of resolution.

2.3  Licensing Overview

An LPCXpresso IDE installation will take one of the following three forms:

• Unregistered : the initial product state following a new customer installation, features
are restricted, and code size is restricted to 8KB
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• Free Edition : following installation of a Free Edition Activation code, maximum debug
download size is limited to 256KB

• Pro Edition : following installation of Purchased Pro Edition Activation code, no
restrictions

Note the current installation type can be identified by Help -> Display License Type

2.3.1  Users of earlier versions of LPCXpresso IDE

If you have previously been using LPCXpresso IDE v5.x or earlier, then note that your
previous activation code is not compatible with this version. You will need to go through
the activation process again in order to use this version.

If you have previously been using LPCXpresso IDE v6.x, then your existing activation code
is compatible with LPCXpresso IDE v7.x. There is no need to reactivate.

2.3.2  Users of Code Red Technologies Red Suite products

Red Suite activation codes are not compatible with LPCXpresso IDE. You will need to
obtain an LPCXpresso Free or Pro Edition activation code in order to use LPCXpresso IDE.

2.4  Unregistered (UNREGISTERED) license

Initially after installation LPCXpresso IDE will run with a default Unregistered
(UNREGISTERED) license. Most features of the product may be used, although some
functionality is restricted, including the size of applications that you can build and debug
(limited to 8Kbytes), and Red Trace functionality is disabled. Activate your product with a
Free Edition or Pro Edition license to remove these restrictions.

2.5  Activating your product (LPCXpresso Free Edition)

A Free Edition activation code may be obtained, free of charge, by registering the
LPCXpresso IDE. This provides a license to use the complete development environment
with a 256KB debug download size limit.

Note: You will need to have created an account and logged on to the LPCWare website
to be able to obtain a Free Edition activation code.

To activate your installation with a Free Edition license, from within LPCXpresso IDE:

1. Go to the menu entry Help->Activate->Create Serial number and register (Free
Edition)...

• Your product’s serial number will be displayed

• Write down the serial number, or copy it into the clipboard.

2. Press OK and a web browser will be opened on the Activations page

• If you are already logged in to the website, the serial number will be completed for you.

• If you are not logged in, you will need to login, navigate to http://www.lpcware.com/
lpcxpresso/activate, and enter the product’s serial number.

3. Press the button to Register LPCXpresso

• Your LPCXpresso Activation code will be generated and displayed.



NXP Semiconductors LPCXpresso v7 User Guide

LPCXpresso v7 User Guide -

User Guide
All information provided in this document is subject to legal disclaimers

Rev. 7.9 — 12 September, 2015
© 2013-2015 NXP Semiconductors. All rights reserved.

12

4. Go to the menu entry Help->Activate->Activate (Free Edition)...

5. Enter your activation code and Press OK.

• This activates your product. The license type will be displayed and you will be able to
use all the features of LPCXpresso, with a debug download limit of 256KB.

2.6  Activating your product (LPCXpresso Pro Edition)

A full, unrestricted activation code for the LPCXpresso IDE can be purchased via the menu
entry Help->Activate->Purchase from LPCXpresso webstore. Once purchased, your
activation code will be emailed to you.

When the activation code is received, follow the instructions below to activate your product.
From within the LPCXpresso IDE:

1. Go to the menu entry Help->Activate->Activate (Pro Edition)...

2. Enter the Pro Edition activation code provided, and press OK

3. Enter your email address and provide a password of your choosing, and press OK.

Your product will now be activated. The license type will be displayed and you will be able
to use all the features of LPCXpresso with no code size limits.

NOTES

1. The password should be kept safe, as it will be required should you wish reactivate your
license (for example to move your license for LPCXpresso Pro Edition from one PC to
another). Your email address will be used to send a reminder should you forget your
password. We may also send occasional emails from which you may unsubscribe.

2. The first use of an activation code will also trigger an email from Softworkz (our licensing
system partners) to the supplied email address. This email is important because it offers
the option to create an account to centrally manage multiple seats of LPCXpresso. See
http://www.lpcware.com/content/faq/lpcxpresso/initial-activation-email

2.6.1  Multi-Seat Activations

When you purchase LPCXpresso Pro Edition, you can choose to purchase a single or multi
seat license. If you purchase a multi seat license, then you will be provided with a single
activation code that can be used to activate LPCXpresso Pro Edition on multiple machines.

The major benefit of a multi seat activation code over multiple single seat codes is that this
enables a single activation code to be made available to users whilst offering the ability to
monitor and administer usage centrally.

Single seat licenses can be upgraded to multi-seat licenses by purchasing additional seats.

For additional information please visit:

http://www.lpcware.com/content/faq/lpcxpresso/central-administration-activation-codes

2.7  Further information on installation and licensing

Further information on LPCXpresso IDE installation, licensing and activation codes can be
found in our FAQs at:

http://www.lpcware.com/faq/activation-licensing
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3. LPCXpresso IDE Overview

3.1  Documentation and Help

The LPCXpresso IDE is based on the Eclipse IDE framework, and many of the core features
are described well in generic Eclipse documentation and in the help files to be found on
the LPCXpresso IDE’s Help -> Help Contents menu. This also provides access to the
LPCXpresso User Guide (this document), as well as the documentation for the compiler,
linker, and other underlying tools.

To obtain assistance on using LPCXpresso visit

http://lpcware.com/lpcxpresso/support

3.2  Workspaces

When you first launch LPCXpresso IDE, you will be asked to select a Workspace, as shown
in Figure 3.1.

Figure 3.1. Workspace selection.

A workspace is simply a directory that is used to store the projects you are currently working
on. Each workspace can contain multiple projects, and you can have multiple workspaces
on your computer. The LPCXpresso IDE can only have a single workspace open at a time,
although it is possible to run multiple instances in parallel — with each instance accessing
a different workspace.

If you tick the Use this as the default and do not ask again option, then the LPCXpresso
IDE will always start up with the chosen workspace opened. Otherwise you will always be
prompted to choose a workspace.

It is also possible to change workspace whilst running the LPCXpresso IDE, using the File
-> Switch Workspace option.

3.3  Perspectives and Views

The overall layout of the main LPCXpresso IDE window is known as a Perspective. Within
each Perspective are many sub-windows, called Views. A View displays a particular set
of data in the LPCXpresso environment. For example, this data might be source code,
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hex dumps, disassembly, or memory contents. Views can be opened, moved, docked, and
closed, and the layout of the currently displayed Views can be saved and restored.

Typically, the LPCXpresso IDE operates using the single Develop Perspective, under
which both code development and debug sessions operate as shown in Figure 3.3. This
single perspective simplifies the Eclipse environment, but at the cost of slightly reducing
the amount of information displayed on screen.

Alternatively the LPCXpresso IDE can operate in a ‘dual perspective’ mode such that the C/
C++ Perspective is used for developing and navigating around your code and the Debug
Perspective is used when debugging your application.

You can manually switch between Perspectives using the Perspective icons in the top right
of the LPCXpresso IDE window, as per Figure 3.2.

Figure 3.2. Perspective selection.

All Views in a Perspective can also be rearranged to match your specific requirements by
dragging and dropping. If a View is accidentally closed, it can be restored by selecting it
from the Window -> Show View dialog.
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3.4  Major components of the Develop Perspective

Figure 3.3. Develop Perspective (whilst debugging)

1. Project Explorer / Peripherals / Registers Views

• The Project Explorer gives you a view of all the projects in your current ‘Workspace’.

• When debugging, the Peripherals view allows you to display the registers within
Peripherals.

• When debugging, the Registers view allows you to display the registers within the
CPU of your MCU.

2. Editor

• On the upper right is the editor, which allows modification and saving of source code.
When debugging, it is here that you will see the code you are executing and can
step from line to line. By pressing the 'i->' icon at the top of the Debug view, you
can switch to stepping by assembly instruction. Clicking in the left margin will set and
delete breakpoints.

3. Console / Problems / Red Trace Views

• On the lower right are the Console and Problems Views. The Console View displays
status information on compiling and debugging, as well as semihosted program
output. The Problem View (available by changing tabs) shows all compiler errors and
will allow easy navigation to the error location in the Editor View.
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• Located in parallel with the Console View are the various views that make up the
Trace functionality of LPCXpresso IDE. The Trace views allow you to gather and
display runtime information using the SWV technology that is part of Cortex-M3/M4
based parts. In addition, for some MCUs, you can also view instruction trace data
downloaded from the MCU’s Embedded Trace Buffer (ETB) or Micro Trace Buffer
(MTB). The example here shows instruction trace information downloaded from an
LPC812’s MTB. For more information on Trace functionality, please see Section 8.1.

4. Quick Start / Variables / Breakpoints / Expressions Views

• On the lower left of the window, the Quickstart Panel has fast links to commonly used
features. This is the best place to go to find options such as Build, Debug, and Import.

• Sitting in parallel to the ‘Quickstart’ view, the Variable view allows you to see the
values of local variables.

• Sitting in parallel to the ‘Quickstart’ view, the Breakpoint view allows you to see and
modify currently set breakpoints.

• Sitting in parallel to the ‘Quickstart’ view, the Expressions view allows you to add
global variables and other expressions so that you can see and modify their values.

5. Debug View

• The Debug view appears when you are debugging your application. This shows
you the stack trace. In the ‘stopped’ state, you can click on any particular function
and inspect its local variables in the Variables tab (which is located parallel to the
Quickstart Panel).
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4. Importing and Debugging example projects

4.1  Software drivers and examples

LPCOpen is now the preferred software platform for most NXP Cortex-M based MCUs,
replacing the various CMSIS / Peripheral Driver Library / code bundle software packages
made available in the past. LPCOpen has been designed to allow you to quickly and easily
utilize an extensive array of software drivers and libraries in order to create and develop
multifunctional products. Amongst the features of LPCOpen are:

• MCU peripheral device drivers with meaningful examples

• Common APIs across device families

• Thoroughly tested and maintained

• Commonly needed third party and open source software ports

• Support for Keil, IAR and LPCXpresso toolchains

The latest LPCOpen v2 now available provides:

• MCU family specific download package

• Support for USB ROM drivers

• Improved code organization and drivers (efficiency, features)

• Improved support for LPCXpresso IDE

CMSIS / Peripheral Driver Library / code bundle software packages are still available,
both within your LPCXpresso IDE install directory \lpcxpresso\Examples\NXP and also
downloadable from NXP LPCware website. But generally these should only be used for
existing development work. When starting a new evaluation or product development, we
would recommend the use of LPCOpen.

More information on LPCOpen together with package downloads can be found at:

http://www.lpcware.com/lpcopen

4.2  Importing an Example project

The Quickstart Panel provides rapid access to the most commonly used features of the
LPCXpresso IDE. Using the Quickstart Panel, you can quickly import example projects,
create new projects, build projects and debug projects.

On the Quickstart Panel, click on the ‘Start Here’ sub-panel, and click on Import project(s).
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Figure 4.1. Import project(s)

As per Figure 4.2, from the first page of the wizard, you can

• Browse to locate Examples stored in zip archive files on your local system. These could
be archives that you have previously downloaded (for example LPCOpen packages from
the NXP LPCware website or the supplied, but deprecated, sample code bundles located
within the Examples subdirectory of your LPCXpresso IDE installation.

• Browse to locate projects stored in directory form on your local system (for example, you
can use this to import projects from a different workspace into the current workspace).

• Browse LPCOpen packages to visit LPCware and download appropriate LPCOpen
package for your target MCU. This option will automatically open a web browser onto an
appropriate links page on the NXP LPCware website.
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Figure 4.2. Import Examples

To demonstrate how to use the Import Project(s) functionality, we will now import the
LPCOpen examples for the LPCXpresso812 development board.

4.2.1  Importing Examples for the LPCXpresso812 Development Board

First of all, assuming that you have not previously downloaded the appropriate LPCOpen
package, click on the Browse LPCOpen Packages, which will open a web browser
window. Click on Download LPCOpen Packages link, and then the link to the LPCOpen
v2.xx for LPC8xx family devices, and then choose the download for the LPCXpresso812
board.

Once the package has downloaded, return to the Import Project(s) dialog and click on the
Browse button next to Project archive (zip) and locate the LPCOpen LPCXpresso812
package archive previously downloaded. Select the archive, click Open and then click
Next. You will then be presented with a list of projects within the archive, as shown in
Figure 4.3.



NXP Semiconductors LPCXpresso v7 User Guide

LPCXpresso v7 User Guide -

User Guide
All information provided in this document is subject to legal disclaimers

Rev. 7.9 — 12 September, 2015
© 2013-2015 NXP Semiconductors. All rights reserved.

20

Figure 4.3. Select projects to import

Select the projects you want to import and then click Finish. The examples will be imported
into your workspace.

Note that generally it is a good idea to leave all projects selected when doing an import from
a zip archive file of examples. This is certainly true the first time you import an example set,
when you will not necessarily be aware of any dependencies between projects. In most
cases, an archive of projects will contain one or more library projects, which are used by the
actual application projects within the examples. If you do not import these library projects,
then the application projects will fail to build.

4.3  Building projects

Building the projects in a workspace is a simple case of using the Quickstart Panel to
‘Build all projects’. Alternatively a single project can be selected in the Project Explorer
View and built. Note that building a single project may also trigger a build of any associated
library projects.

4.3.1  Build configurations

By default, each project will be created with two different ‘build configurations’ - Debug
and Release. Each build configuration will contain a distinct set of build options. Thus a
Debug build will typically compile its code with optimizations disabled ( -O0) and Release
will compile its code optimizing for minimum code size ( -Os). The currently selected build
configuration for a project will be displayed after its name in the Quickstart Panel’s Build/
Clean/Debug options.

For more information on switching between Build Configurations, see the FAQ at

http://www.lpcware.com/content/faq/lpcxpresso/change-build-config
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